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This symbol is intended to alert the user of important operating and mainte-
nance (servicing) instructions in the literature provided with the equipment.

This symbol is intended to alert the user of the presence of uninsulated 
dangerous voltage within the product’s enclosure that may present a risk of 
electric shock.

Caution
Read Instructions • Read and understand all safety and operating instructions before using the equipment.

Retain Instructions • The safety instructions should be kept for future reference.

Follow Warnings • Follow all warnings and instructions marked on the equipment or in the user information.

Avoid Attachments • Do not use tools or attachments that are not recommended by the equipment 
manufacturer because they may be hazardous.

Warning
Power sources • This equipment should be operated only from the power source indicated on the product. This 

equipment is intended to be used with a main power system with a grounded (neutral) conductor. The third 
(grounding) pin is a safety feature, do not attempt to bypass or disable it.

Power disconnection • To remove power from the equipment safely, remove all power cords from the rear of 
the equipment, or the desktop power module (if detachable), or from the power source receptacle (wall plug).

Power cord protection • Power cords should be routed so that they are not likely to be stepped on or pinched 
by items placed upon or against them.

Servicing • Refer all servicing to qualified service personnel. There are no user-serviceable parts inside. To prevent 
the risk of shock, do not attempt to service this equipment yourself because opening or removing covers may 
expose you to dangerous voltage or other hazards.

Slots and openings • If the equipment has slots or holes in the enclosure, these are provided to prevent 
overheating of sensitive components inside. These openings must never be blocked by other objects.

Lithium battery • There is a danger of explosion if battery is incorrectly replaced. Replace it only with the 
same or equivalent type recommended by the manufacturer. Dispose of used batteries according to the 
manufacturer’s instructions.

Ce symbole sert à avertir l’utilisateur que la documentation fournie avec le 
matériel contient des instructions importantes concernant l’exploitation et la 
maintenance (réparation).

Ce symbole sert à avertir l’utilisateur de la présence dans le boîtier 
de l’appareil de  tensions dangereuses non isolées posant des risques 
d’électrocution.

Attention
Lire les instructions• Prendre connaissance de toutes les consignes de sécurité et d’exploitation avant 

d’utiliser le matériel.

Conserver les instructions• Ranger les consignes de sécurité afin de pouvoir les consulter à l’avenir.

Respecter les avertissements • Observer tous les avertissements et consignes marqués sur le matériel ou 
présentés dans la documentation utilisateur.

Eviter les pièces de fixation • Ne pas utiliser de pièces de fixation ni d’outils non recommandés par le 
fabricant du matériel car cela risquerait de poser certains dangers.

Avertissement
Alimentations • Ne faire fonctionner ce matériel qu’avec la source d’alimentation indiquée sur l’appareil. Ce 

matériel doit être utilisé avec une alimentation principale comportant un fil de terre (neutre). Le troisième 
contact (de mise à la terre) constitue un dispositif de sécurité : n’essayez pas de la contourner ni de la 
désactiver.

Déconnexion de l’alimentation• Pour mettre le matériel hors tension sans danger, déconnectez tous les 
cordons d’alimentation de l’arrière de l’appareil ou du module d’alimentation de bureau (s’il est amovible) ou 
encore de la prise secteur.

Protection du cordon d’alimentation • Acheminer les cordons d’alimentation de manière à ce que personne 
ne risque de marcher dessus et à ce qu’ils ne soient pas écrasés ou pincés par des objets.

Réparation-maintenance • Faire exécuter toutes les interventions de réparation-maintenance par un 
technicien qualifié. Aucun des éléments internes ne peut être réparé par l’utilisateur. Afin d’éviter tout danger 
d’électrocution, l’utilisateur ne doit pas essayer de procéder lui-même à ces opérations car l’ouverture ou le 
retrait des couvercles risquent de l’exposer à de hautes tensions et autres dangers.

Fentes et orifices • Si le boîtier de l’appareil comporte des fentes ou des orifices, ceux-ci servent à empêcher les 
composants internes sensibles de surchauffer. Ces ouvertures ne doivent jamais être bloquées par des objets.

Lithium Batterie • Il a danger d’explosion s’ll y a remplacment incorrect de la batterie. Remplacer uniquement 
avec une batterie du meme type ou d’un ype equivalent recommande par le constructeur. Mettre au reut les 
batteries usagees conformement aux instructions du fabricant.

Safety Instructions • English

Consignes de Sécurité • Français

Sicherheitsanleitungen • Deutsch
Dieses Symbol soll dem Benutzer in der im Lieferumfang enthaltenen 
Dokumentation besonders wichtige Hinweise zur Bedienung und Wartung 
(Instandhaltung) geben.

Dieses Symbol soll den Benutzer darauf aufmerksam machen, daß im Inneren 
des Gehäuses dieses Produktes gefährliche Spannungen, die nicht isoliert sind 
und die einen elektrischen Schock verursachen können, herrschen.

Achtung
Lesen der Anleitungen • Bevor Sie das Gerät zum ersten Mal verwenden, sollten Sie alle Sicherheits-und 

Bedienungsanleitungen genau durchlesen und verstehen.

Aufbewahren der Anleitungen • Die Hinweise zur elektrischen Sicherheit des Produktes sollten Sie 
aufbewahren, damit Sie im Bedarfsfall darauf zurückgreifen können.

Befolgen der Warnhinweise • Befolgen Sie alle Warnhinweise und Anleitungen auf dem Gerät oder in der 
Benutzerdokumentation.

Keine Zusatzgeräte • Verwenden Sie keine Werkzeuge oder Zusatzgeräte, die nicht ausdrücklich vom 
Hersteller empfohlen wurden, da diese eine Gefahrenquelle darstellen können.

Vorsicht
Stromquellen • Dieses Gerät sollte nur über die auf dem Produkt angegebene Stromquelle betrieben werden. 

Dieses Gerät wurde für eine Verwendung mit einer Hauptstromleitung mit einem geerdeten (neutralen) Leiter 
konzipiert. Der dritte Kontakt ist für einen Erdanschluß, und stellt eine Sicherheitsfunktion dar. Diese sollte nicht 
umgangen oder außer Betrieb gesetzt werden.

Stromunterbrechung • Um das Gerät auf sichere Weise vom Netz zu trennen, sollten Sie alle Netzkabel aus der 
Rückseite des Gerätes, aus der externen Stomversorgung (falls dies möglich ist) oder aus der Wandsteckdose 
ziehen.

Schutz des Netzkabels • Netzkabel sollten stets so verlegt werden, daß sie nicht im Weg liegen und niemand 
darauf treten kann oder Objekte darauf- oder unmittelbar dagegengestellt werden können.

Wartung • Alle Wartungsmaßnahmen sollten nur von qualifiziertem Servicepersonal durchgeführt werden. 
Die internen Komponenten des Gerätes sind wartungsfrei. Zur Vermeidung eines elektrischen Schocks 
versuchen Sie in keinem Fall, dieses Gerät selbst öffnen, da beim Entfernen der Abdeckungen die Gefahr eines 
elektrischen Schlags und/oder andere Gefahren bestehen.

Schlitze und Öffnungen • Wenn das Gerät Schlitze oder Löcher im Gehäuse aufweist, dienen diese zur 
Vermeidung einer Überhitzung der empfindlichen Teile im Inneren. Diese Öffnungen dürfen niemals von 
anderen Objekten blockiert werden.

Litium-Batterie • Explosionsgefahr, falls die Batterie nicht richtig ersetzt wird. Ersetzen Sie verbrauchte Batterien 
nur durch den gleichen oder einen vergleichbaren Batterietyp, der auch vom Hersteller empfohlen wird. 
Entsorgen Sie verbrauchte Batterien bitte gemäß den Herstelleranweisungen.

Este símbolo se utiliza para advertir al usuario sobre instrucciones impor-
tantes de operación y mantenimiento (o cambio de partes) que se desean 
destacar en el contenido de la documentación suministrada con los equipos.

Este símbolo se utiliza para advertir al usuario sobre la presencia de elemen-
tos con voltaje peligroso sin protección aislante, que puedan encontrarse 
dentro de la caja o alojamiento del producto, y que puedan representar 
riesgo de electrocución.

Precaucion
Leer las instrucciones • Leer y analizar todas las instrucciones de operación y seguridad, antes de usar el 

equipo.

Conservar las instrucciones • Conservar las instrucciones de seguridad para futura consulta.

Obedecer las advertencias • Todas las advertencias e instrucciones marcadas en el equipo o en la 
documentación del usuario, deben ser obedecidas.

Evitar el uso de accesorios • No usar herramientas o accesorios que no sean especificamente 
recomendados por el fabricante, ya que podrian implicar riesgos.

Advertencia
Alimentación eléctrica • Este equipo debe conectarse únicamente a la fuente/tipo de alimentación eléctrica 

indicada en el mismo. La alimentación eléctrica de este equipo debe provenir de un sistema de distribución 
general con conductor neutro a tierra. La tercera pata (puesta a tierra) es una medida de seguridad, no 
puentearia ni eliminaria.

Desconexión de alimentación eléctrica • Para desconectar con seguridad la acometida de alimentación 
eléctrica al equipo, desenchufar todos los cables de alimentación en el panel trasero del equipo, o desenchufar 
el módulo de alimentación (si fuera independiente), o desenchufar el cable del receptáculo de la pared.

Protección del cables de alimentación • Los cables de alimentación eléctrica se deben instalar en lugares 
donde no sean pisados ni apretados por objetos que se puedan apoyar sobre ellos.

Reparaciones/mantenimiento • Solicitar siempre los servicios técnicos de personal calificado. En el interior no 
hay partes a las que el usuario deba acceder. Para evitar riesgo de electrocución, no intentar personalmente la 
reparación/mantenimiento de este equipo, ya que al abrir o extraer las tapas puede quedar expuesto a voltajes 
peligrosos u otros riesgos.

Ranuras y aberturas • Si el equipo posee ranuras o orificios en su caja/alojamiento, es para evitar el 
sobrecalientamiento de componentes internos sensibles. Estas aberturas nunca se deben obstruir con otros 
objetos.

Batería de litio • Existe riesgo de explosión si esta batería se coloca en la posición incorrecta. Cambiar esta 
batería únicamente con el mismo tipo (o su equivalente) recomendado por el fabricante. Desachar las baterías 
usadas siguiendo las instrucciones del fabricante.

Instrucciones de seguridad • Español

安全须知 • 中文
这个符号提示用户该设备用户手册中有重要的操作和维护说明。

这个符号警告用户该设备机壳内有暴露的危险电压，有触电危险。

注意
阅读说明书 • 用户使用该设备前必须阅读并理解所有安全和使用说明。

保存说明书 • 用户应保存安全说明书以备将来使用。

遵守警告 • 用户应遵守产品和用户指南上的所有安全和操作说明。

避免追加 • 不要使用该产品厂商没有推荐的工具或追加设备，以避免危险。

警告
电源 • 该设备只能使用产品上标明的电源。 设备必须使用有地线的供电系统供电。 第三条线

（地线）是安全设施，不能不用或跳过 。

拔掉电源 • 为安全地从设备拔掉电源，请拔掉所有设备后或桌面电源的电源线，或任何接到市
电系统的电源线。

电源线保护 • 妥善布线， 避免被踩踏，或重物挤压。

维护 • 所有维修必须由认证的维修人员进行。 设备内部没有用户可以更换的零件。为避免出现
触电危险不要自己试图打开设备盖子维修该设备。

通风孔 • 有些设备机壳上有通风槽或孔，它们是用来防止机内敏感元件过热。 不要用任何东
西挡住通风孔。

锂电池 • 不正确的更换电池会有爆炸的危险。必须使用与厂家推荐的相同或相近型号的电池。
按照生产厂的建议处理废弃电池。



FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC rules. The Class A limits provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instruction guide, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause interference; the user must correct the interference at his own expense.

NOTE:	 This unit was tested with shielded I/O cables on the peripheral devices. Shielded 
cables must be used to ensure compliance with FCC emissions limits.

For more information on safety guidelines, regulatory compliances,  
EMI/EMF compatibility, accessibility, and related topics, see the “Extron Safety 
and Regulatory Compliance Guide” on the Extron website.

Specifications Availability
Product specification are available on the Extron website, www.extron.com.

Conventions Used in this Guide

Notifications the following are used:

WARNING:	 A warning indicates a situation that has the potential to result in death or 
severe injury. 

ATTENTION:	 Attention indicates a situation that may damage or destroy the product or 
associated equipment. 

NOTE:	 A note draws attention to important information.

http://media.extron.com/download/files/userman/Safety-Compliances_68-290-01_I_012609.pdf
http://media.extron.com/download/files/userman/Safety-Compliances_68-290-01_I_012609.pdf


Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C
[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” 
represents the capital letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32
C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t
SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Copyright
© 2012 Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.



Contents

Introduction............................................. 1

About this Guide.............................................. 1
About the FOX DA8 Plus................................... 2
Features............................................................ 3

Installation and Operation...................... 4

Rear Panel Features........................................... 4
Front Panel Features.......................................... 7
System Operation............................................. 7

Configuration............................................... 8

Remote Control........................................ 9

Remote Control Ports........................................ 9
Simple Instruction Set Control......................... 10

Host-to-interface Communications.............. 10
Start-up Message........................................ 10
Error Responses.......................................... 10
Timeout...................................................... 10
Using the Command and Response Table.... 10

FOX Extenders Control Program...................... 12
Installing the Software................................ 12
Using the Program...................................... 13
Firmware Upgrade...................................... 15

Reference Information...........................19

Part Numbers and Accessories......................... 19
FOX DA8 Plus Part Numbers........................ 19
Included Parts............................................. 19
Optional Accessories................................... 19
Compatible Equipment............................... 20
Fiber Cables................................................ 21

Mounting the Unit.......................................... 22
Rack Mounting UL Guidelines..................... 22

 

FOX DA8 Plus • Contents v



FOX DA8 Plus • Contents vi

 



Introduction

The topics covered in this section are:

•	 About this Guide

•	 About the FOX DA8 Plus

•	 Features

WARNING:	 Risk of serious physical injury: The FOX DA8 Plus outputs continuous 
invisible light, which may be harmful to the eyes; use with caution.

•	 Do not look into the rear panel fiber optic cable connectors or into 
the fiber optic cables themselves.

•	 Plug the attached dust caps into the optical transceivers when the fiber 
cable is unplugged.

About this Guide
This guide contains information about the two models of Extron FOX DA8 Plus fiber optic 
distribution amplifiers (DAs). The FOX DA8 Plus is available in two transmission modes that 
define the transmission range of the DA:

•	 FOX DA8 Plus MM — A 1-input, 8-output multimode DA, with a range of up to 2 km 
(6561 feet) on the input and on each output

•	 FOX DA8 Plus SM — A 1-input, 8-output singlemode DA, with a very long range of up 
to 30 km (18.75 miles) on the input and on each output

NOTES:	 •	 The multimode and singlemode DAs are physically and functionally 
identical with the exception of the effective range of transmission. 
In this guide, the terms “FOX DA8 Plus” and “FOX DA” refer to a DA of 
either transmission mode.

•	 Many products are compatible with the FOX DA8 Plus. They are identified 
where appropriate, but not specifically described in this guide.

•	 The FOX DA8 Plus MM and the FOX DA8 Plus SM are not compatible.
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About the FOX DA8 Plus
The FOX DA8 Plus units are singlemode and multimode ultra-high performance fiber optic 
distribution amplifiers. The DA (see figure 1) accepts a proprietary input optical signal from 
a compatible Extron fiber optic transmitter (Tx) or other device. The optical signal can include 
video, audio, and one-way (transmitter-to-receiver [Rx]) RS-232 communications.
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Figure 1.	 Typical FOX DA8 Plus Application

NOTES:	 •	 Compatible optical signals are digital signals from 2.0 Mbps through 
4.25 Gbps that are sent and received via fiber optic SFP modules.

•	 The video component of the signal from an Extron Tx can be either 
VGA - UXGA RGB video, High-Definition Multimedia Interface (HDMI), or 
digital visual interface (DVI) video.

•	 Distribution of HDMI video is not HDCP-compliant.

•	 The serial component of the signal is for applications such as projector control 
and transmitter control of the receiver.

The FOX DA8 Plus actively splits the proprietary signal into eight identical optical signals and 
outputs the signals on fiber optic cables to compatible receivers.

NOTES:	 •	 The eight optical outputs are identical.

•	 The FOX DA8 Plus does not support transmission of a return (Rx-to-Tx) serial 
data stream.

•	 The DA can receive and send the proprietary signal from and to any compatible 
Extron fiber optic transmitter, receiver, or switcher (see “Compatible 
Equipment” on page 20 for a partial list of compatible products).

The connected receivers convert the proprietary signals back to video (RGB, HDMI, or 
DVI, depending on the source transmitter and the receiver), audio, and serial RS-232 
communication, and output the signals locally. For video resolutions up to 1900x1200, the 
video outputs for the receivers are a perfect, pixel-for-pixel or digital recreation of the video 
signal input to the FOX DA8 Plus via a transmitter.
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Features
Ultra high performance — Outputs up to eight perfect, pixel-by-pixel RGBHV or digital 
video transmissions to compatible receivers. The FOX DA8 Plus can handle analog video 
resolutions up to 1900x1200 at 60 Hz. Higher resolutions can be transmitted, but with some 
loss of video quality.

Optical input and outputs — The FOX DA8 Plus inputs and outputs the optical signal on 
LC video connectors.

Active and individually isolated outputs — The FOX DA8 Plus uses active signal splitting 
to maintain equal transmitter power to all outputs, maximizing distance capabilities by 
ensuring full availability of optical loss budget for each output.

Three user selectable DA configurations — Configurable as a single 8-output 
distribution amplifier, or as two 4-output or four 2-output distribution amplifiers.

Selectable input reclocking — Reshapes and restores timing of the digital signal on the 
input (affecting the buffered output) at a rate selected among 4.25 Gbps, 2.125 Gbps, or 
1.25 Gbps. You can also bypass the reclocking function.

Remote control operation — The DA can be remotely controlled via either of two remote 
control ports. Control is using either the Simple Instructrion Set (SIS™) or the Extron FOX 
Extenders Control Program.

Front panel USB configuration port — The FOX DA8 Plus features a front panel USB port 
provides easy access for remote control operation. 

RS-232 control — The FOX DA8 Plus features a rear panel RS-232 serial port for remote 
control operation.

Rack mounting — The unit is rack mountable in any conventional 19-inch wide rack, using 
an Extron full size rack shelf.

Power — The 100 VAC to 240 VAC, internal power supply provides worldwide power 
compatibility.
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Installation and 
Operation

The topics covered in this section are:

•	 Rear Panel Features

•	 Front Panel Features

•	 System Operation

Rear Panel Features
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Figure 2.	 FOX DA8 Plus Connectors

WARNING:	 Risk of serious physical injury: This unit outputs continuous invisible 
light, which may be harmful to the eyes; use with caution. For additional 
safety, plug the attached dust caps into the optical transceivers when the 
fiber optic cable is unplugged.

NOTES:	 •	 Input LC connectors (on the right) marked with an asterisk (*) in figure 2 
(inputs 3, 5, and 7) are functional only when selected as an input using the 
DA configuration switch (item d). The connector on the right for transceiver 
blocks 2, 4, 6, and 8 can never be functional.

	 •	 Singlemode and multimode devices are not interchangeable. Ensure that 
you connect transmitting and receiving devices that are compatible with the 
FOX DA8 Plus.

•	 Ensure that you use the proper fiber cable for your system. Typically, 
singlemode fiber has a yellow jacket and multimode cable has an orange or 
aqua jacket.

•	 In this guide, the term “sending connector” refers to an LC connector on a 
device that outputs a fiber optic signal. The term “receiving connector” refers 
to an LC connector that receives an optical signal.
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a	 AC power connector — Plug a standard IEC power cord into this connector to connect 
the FOX DA8 Plus to a 100 VAC to 240 VAC, 50-60 Hz power source.

b	 Input connectors and LEDs —	
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NOTE:	 Input LC connectors (on the right) marked with an 
asterisk (*) in figure 2 are functional only when selected as 
an input using the DA configuration switch (item d). The 
right-hand connector for transceiver blocks 2, 4, 6, and 8 
can never be functional.

Optical transceiver Input connector — For one-way video, audio, 
and serial communications from the transmitter to the FOX DA8 Plus for 
distribution to the receivers, connect a fiber cable to the optical 
transceiver input LC connector on transceiver block 1 ( the LC connector 
on the right).

Connect the far end of this fiber optic cable to the sending connector on 
the transmitter or another compatible Extron device.

Optical transceiver block 1 Input LED — When this LED is lit, the link 
is active (light is received from the transmitter).

NOTE:	 The LEDs on the right for transceiver blocks 2, 4, 6, and 8 
may light, but do not indicate that there is an input to that 
connector.

c	 Output connectors and LEDs —

Connectors — For one-way video, audio, and serial communications 
from the FOX DA8 Plus to the receivers, connect up to eight fiber optic 
cables to the output LC connectors on transceiver blocks 1 through 8.

Connect the far ends of these fiber optic cables to the receiving 
connectors on the receivers or other compatible Extron devices.

LEDs — These LEDs are always lit, whether the output is active 
(unmuted) or not.

d	 DA configuration switch — Set this switch to configure the unit in 
any of the following configurations (see “Configuration“on page 8).

•	 One 8-output DA	
(1

)1
x8

(2
)1

x4
(4

)1
x2

•	 Two 4-output DAs

•	 Four 2-output DAs
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e	 RS-232 port — For serial control of the DA, connect a host device, such as a computer, 
touch panel control, or RS-232 capable PDA, via this 3-pole captive screw connector (see 
figure 3, below, to wire this connector).

Do not tin the wires!
Controlling

Device

Ground
Receive (Rx)
Transmit (Tx)

Ground
Receive (Rx)
Transmit (Tx)

Bidirectional

FunctionPin
TX
RX
Gnd

Transmit data
Receive data
Signal ground

Tx Rx

NOTE: Cross the Tx and Rx lines once between the source and the target.

RS-232

Figure 3.	 RS-232 Connector

NOTES:	 •	 The length of exposed wires is critical. The ideal length is 3/16 inches 
(5 mm).

•	 If the stripped section of wire is longer than 3/16 inches, the exposed 
wires may touch, causing a short circuit.

•	 If the stripped section of wire is shorter than 3/16 inches, wires can be 
easily pulled out even if tightly fastened by the captive screws.

This port is RS-232 only, with the following protocols:

•	 9600 baud •	 no parity •	 8 data bits

•	 1 stop bit •	 no flow control
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Front Panel Features

FOX DA SERIES

CONFIG

FIBER OPTIC DISTRIBUTION AMPLIFIER

1 2

Figure 4.	 FOX DA8 Plus Front Panel Features

a	 Power LED — This LED lights when power is applied to the unit.

b	 Config(uration) port — For USB control of the DA, connect a host device, such as a 
computer or touch panel control, via this mini USB B port.

System Operation
After the transmitter, the FOX DA8 Plus, the receivers, and their connected devices are 
powered up, the system is fully operational. If any problems are encountered, ensure all 
traditional and fiber cables are routed and connected properly:

•	 Ensure that the video source and the displays are properly connected to the transmitter, 
the FOX DA8 Plus, and the receivers, and that all equipment has power applied.

•	 Ensure that the rear panel Input monitoring LED (see figure 2, item b) is indicating 
correctly for your system configuration.

NOTE:	 If problems persist, call the Extron S3 Sales and Technical Support Hotline (see 
Contact Information on the last page of this guide for the phone number 
in your region of the world).
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Configuration
The DA configuration switch selects any of the three configurations as identified in figure 5, 
below.

NOTE:	 When you change the position of the DA configuration switch, the reclocking 
feature returns to the default setting of 4.25 Gbps on all inputs. See the 
Reclocking information in the SIS commands section and FOX Extenders 
section to set the reclocking feature to the desired values.

FOX DA8 Plus100-240V    0.3A

OPTICAL OUTPUTS

A B C D

OUT IN
1

OUT IN
3

OUT IN
5

OUT IN
7

(1
)1

x8
(2

)1
x4

(4
)1

x2

50/60 Hz

RS-232 

Tx Rx

OUT N/A
4

OUT N/A
6

OUT N/A 
8

OUT N/A
2

FOX DA8 Plus100-240V    0.3A

OPTICAL OUTPUTS

A B C D

OUT IN
1

OUT IN
3

OUT IN
5

OUT IN
7

(1
)1

x8
(2

)1
x4

(4
)1

x2

50/60 Hz

RS-232 

Tx Rx

OUT N/A
4

OUT N/A
6

OUT N/A 
8

OUT N/A
2

FOX DA8 Plus100-240V    0.3A

OPTICAL OUTPUTS

A B C D

OUT IN
1

OUT IN
3

OUT IN
5

OUT IN
7

(1
)1

x8
(2

)1
x4

(4
)1

x2

50/60 Hz

RS-232 

Tx Rx

OUT N/A
4

OUT N/A
6

OUT N/A 
8

OUT N/A
2

Rx

Tx

Tx Tx

Tx TxTx Tx

Rx Rx Rx Rx Rx Rx Rx

Rx Rx Rx Rx Rx Rx Rx Rx

Rx Rx Rx Rx Rx Rx Rx Rx

CGroup: A

Group: A C DB

(1
)1

x8
(2

)1
x4

(4
)1

x2

(1
)1

x8
(2

)1
x4

(4
)1

x2

(1
)1

x8
(2

)1
x4

(4
)1

x2

One 8-output DA
• Not grouped.

• Single input on input 1
• Outputs 1 through 8

Two 4-output DAs
• Group A:

• Input 1
• Outputs 1 through 4

• Group C:
• Input 5
• Outputs 5 through 8

Four 2-output DAs
• Group A:

• Input 1
• Outputs 1 and 2

• Group B:
• Input 3
• Outputs 3 and 4

• Group C:
• Input 5
• Outputs 5 and 6

• Group D:
• Input 7
• Outputs 7 and 8

• Group C:
• Input 5
• Outputs 5 and 6

• Group D:
• Input 7
• Outputs 7 and 8

Figure 5.	 DA Configurations Based on Switch Position
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Remote Control

The topics covered in this section are:

•	 Remote Control Ports

•	 Simple Instruction Set Control

•	 FOX Extenders Program

Remote Control Ports
The FOX DA8 Plus has two ports that can be connected to a host device such as a computer 
running the Extron DataViewer utility or the HyperTerminal utility, an RS-232 capable PDA, or 
a control system. These ports make remote control of the DA possible. The ports are:

•	 The rear panel RS-232 port — This is a 3-pole captive screw connector (item e on 
page 6). The protocol for this port is as follows:

•	 9600 baud •	 no parity •	 8 data bits

•	 1 stop bit •	 no flow control

•	 The front panel Config(uration) port — This is a mini USB B port and requires the 
DataViewer utility (version 2.0 or newer).

NOTE:	 Before you use the USB port for the first time, you need to install and 
activate the USB driver on your computer. The simplest way to do this is to 
install version 1.5 or newer of the FOX Extenders Program and then run the 
Found New Hardware Wizard (see “Installing the Software“ on page 12 
and “Activating a USB port for the first time“ on page 13.
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Simple Instruction Set Control

Host-to-interface Communications
The Extron Simple Instruction Set (SIS) commands consist of one or more characters per 
field. No special characters are required to begin or end a command character sequence. 
When a command is valid, the unit executes the command and sends a response to the host 
device. All responses from the unit to the host end with a carriage return and a line feed 
(CR/LF = ]), which signals the end of the response character string. A string is one or more 
characters.

Start-up Message
The FOX DA8 Plus issues the following copyright message when it first powers on. Vx.xx is 
the firmware version number, 60-1171-xx is the part number.

(C) COPYRIGHT 20yy, EXTRON ELECTRONICS FOX DA8 PLUS SM (or MM),
Vx.xx, 60-1171-xx]

Error Responses
When the unit receives a valid SIS command, it executes the command and sends a response 
to the host device. If the unit is unable to execute the command because the command is 
invalid or it contains invalid parameters, the unit returns an error response to the host. The 
error response codes are:

E10] — Invalid command

E12] — Invalid output number

E13] — Invalid range

E14] — Not available for current configuration

Timeout
Pauses of 10 seconds or longer between command ASCII characters result in a timeout. The 
command operation is aborted with no other indication.

Using the Command and Response Table
The Command and Response Table for SIS Commands begins on page 11. Commands 
in the table are NOT case sensitive. The ASCII to Hex conversion table, below, is for use with 
the command and response table.

ASCII to Hex  Conversion Table

•

Space
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Symbol Definitions
Symbols (variables), defined below, are used in the command and response table. The 
symbols represent variables in the command and response table fields.

]	 = Carriage return and line feed

}	 = Carriage return  (no line feed)

•	 = space

X!	 =	 Output	 1 through 8

X@	 =	 Mute status	 0 = off (unmuted)	 1 = on (muted)

X#	 =	 Reclockable input number	 00 = all inputs 
01 = input 1 (group A)	 03 = input 3 (group B) 
05 = input 5 (group C)	 07 = input 7 (group D)

X$	 =	 Input reclocker rate	 00 = Bypass (no reclocking)	 02 = 2.125 Gbps 
01 = 1.25 Gbps	 03 = 4.25 Gbps (default)

X%	 =	 Name	 Up to 24 alphanumeric characters, excluding spaces or blank characters. The 
first character must be alphabetic and the last character cannot be a hyphen or 
or minus sign.

X^	 =	 Firmware version	 Vx.xx

X&	 =	 Transceiver module status	 0 = no light input	 1 = light input

X*	 =	 Temperature	 nnnF = whole degree Fahrenheit

X(	 =	 Transceiver module status	 0 = no module installed	 2 = singlemode	 1 = multimode

X1)	 =	 DA configuration switch position	 1 = 1x8 DA (Default)	 2 = Two 1x4 DAs	 3 = Four 1x2 DAs

Command and Response Table for SIS Commands
Command Function ASCII Command 

(Host to Unit)
Response 
(Unit to Host)

Additional Description

Mutes

NOTE:	 The channel mute commands mute the data on the output only. The output continues to emit light.

Mute output X!*1B VmtX!*1] Blank data on optical output X!.

Unmute output X!*0B VmtX!*0] Output data on optical output X!.

Show video mute status X!B X@] Output X! data output mute status is X@.

Mute all outputs 1*B Vmt1] Blank data on all optical outputs.

Unmute all outputs 0*B Vmt0] Output data on all optical outputs.

Show mute status of all outputs EVM} X@1X@2X@3X@4 ... X@8] Show output 1 through output 8 mute 
status.

Reclocking
Set reclocker mode X#*X$= RteX#*X$] Set the reclocker mode for input X# to X$.

Example 1: 0*0= Rte00*00] Set the reclocker mode for all inputs to 
bypass (do not reclock).

Example 2: 5*2= Rte05*02] Set the reclocker mode for input 5 
(group C) to 2.125 Gbps.

Show reclocker mode X#= X$]

Device naming
Set device name EX%CN} Ipn•X%] Set the name of the DA to X%.

Example: EActive_DA_1CN} Ipn•Active_DA_1] Name the unit “Active_DA_1.”

Set device to factory default name E•CN} Ipn•FOX-DA8-Plus]

View device name ECN} X%] The device name is X%.

Information Requests
Information request I V01X08•A00X00] V01X08 shows the number of available 

inputs (1) and outputs (8) for this 
product. A00X00 has no meaning for 
this product.

Show firmware version Q X^]

Example: Q 1.23] The factory-installed controller firmware 
version is 1.23 (sample value only).
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Command Function ASCII Command 
(Host to Unit)

Response 
(Unit to Host)

Additional Description

Information Requests (continued)
Request part number N 60-1171-nn] nn indicates the transmission mode. 

01 = multimode, 02 = singlemode.

Show input connections status 0LS X&1X&2X&3X&4 ... X&8] Show light status of all inputs.

Show temperature 20S X*] X* = degrees Fahrenheit.

Show transceiver module status 0*1I X(1X(2X(3X(4 ... X(8] Show all installed transceiver modules.

Show DA configuration switch position ESTAT} X1)]

FOX Extenders Control Program
The Extron FOX Extenders Control Program, which communicates with the FOX DA8 Plus 
via the rear panel RS-232 port or the front panel Configuration port of the unit, provides an 
easy way to control the DA mute function and set reclocker rates for the inputs.

The program is compatible with Windows® 2000, Windows XP, Windows 7, and newer 
operating systems. Updates to this program can be downloaded from the Extron website 
(www.extron.com).

Installing the Software
The program is contained on the Extron Software Products DVD. Install the software as 
follows:

1.	 Insert the DVD into the drive. The Extron software DVD window should open 
automatically (see figure 6, below). If it does not self-open, run Launch.exe from the 
DVD.

Figure 6.	 Software DVD Window

2.	 Click the Software tab (see figure 6).	

3.	 Scroll to the desired program and click Install (see figure 7, below).

Figure 7.	 Software Installation

4.	 Follow the on-screen instructions. By default, the Windows installation creates a 
C:\Program Files\Extron\FOX_Extenders directory, and it places the following four 
icons into a group folder named Extron Electronics\FOX Extenders:

•	 Check for FOX Extenders updates

•	 FOX Extenders Control Program

•	 FOX Extenders Help

•	 Uninstall FOX Extenders Control Program
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Using the Program

NOTE:	 The first time you connect to the Configuration (USB) port, the Found New 
Hardware Wizard appears (see figure 8, below). See “Activating a USB port 
for the first time,“ below.

	 For other connections, proceed to “Starting the program,” on the next page.
 

1

1
  

2

2

Figure 8.	 Found New Hardware Wizard

Activating a USB port for the first time
The first time you connect to the Configuration (USB) port, the Found New Hardware Wizard 
appears (figure 8). Activate the connected USB port for your device as follows:

NOTE:	 If you have not installed the latest FOX Extenders Control Program (version 1.5 
or newer), click Cancel, install the program, and reboot the PC. Reconnect the 
computer to the Configuration port on the DA.

1.	 Select the No, not this time radio button and click Next.

2.	 Select the Install the software automatically radio button and click Next. 
Follow the on-screen instructions. The wizard assigns the driver necessary to access the 
DA to the connected Configuration (USB) port (this may take a few minutes).

3.	 Click Finish to exit the wizard.

4.	 Proceed to “Starting the program” on the next page or return to the “Simple 
Instruction Set Control” section.

NOTE:	 You may need to repeat these steps if you subsequently connect the DA to 
a different USB port on the same computer.
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Starting the program
Start the Extron FOX Extenders Control Program as follows:

1.	 Connect a computer that runs the Windows operating system to either the RS-232 port 
or the Configuration port of the DA (see “Installation and Operation,” beginning on 
page 4).

2.	 Click Start > Programs > Extron Electronics > FOX Extenders Control 
Program > FOX Extenders.

The Communication Setup window appears (see figure 9, below).

Figure 9.	 Communication Setup Window

3.	 If necessary, select the tab, RS-232 or USB, for the port you are using for the 
connection.

4.	 Depending on the tab that is selected, choose either:

•	 RS-232 tab — The Com port to which your DA is connected

•	 USB tab — Extron USB Device_0

5.	 Click Connect. The FOX Extenders Control Program window appears (see figure 10, 
below.

Figure 10.	 FOX Extenders Program Window
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TIP:	 If you change the configuration of the DA using the rear panel DA 
configuration DIP switch (item d in figure 2 and on page 5), click the Refresh 
button ( ). This forces the FOX Extenders Control Program to show the new 
configuration.

6.	 Operate the DA as follows:

•	 Click the appropriate buttons to mute (gray) or unmute (green) individual outputs or 
all outputs.

WARNING:	 Risk of serious physical injury: The channel mute command 
mutes the data on the output only. The output continues to emit 
potentially dangerous laser light.

•	 Use the drop-down menu to bypass reclocking of the outputs or to select a data 
rate at which to reclock the outputs.

Firmware Upgrade
Firmware can be upgraded via the front panel Configuration port of the unit only, using the 
Extron Firmware Loader utility from the FOX Extenders Control Program.

Upload replacement firmware as follows:

1.	 Visit the Extron website, www.extron.com, click the Download tab, and then click the 
Firmware link (see figure 11, below.

 

3

2

3

NOTE: The name, version, release 
date, and size shown are 
sample values only.

1

1

Figure 11.	 Location of Firmware Upgrade Files

2.	 Select the appropriate firmware file (FOX DA8 Plus) and click Download.

3.	 Enter the requested personal information and then click Download to copy the firmware 
to your computer.
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4.	 Click Run on the next two screens (see figure 12, below). The PC downloads the 
firmware update from the Extron website and starts the Extron Installation Program to 
extract the firmware file.

 

6

4

5

4

Folder where
firmware is
installed

NOTE: The name, version and 
file size shown are 
sample values only.

Figure 12.	 Downloading Firmware Upgrade Files
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5.	 Click Next. The program extracts the firmware files and places them in a folder 
identified in the InstallShield Wizard window.

NOTE:	 Note the folder to which the firmware file is saved.

6.	 Click Finish to exit the program.

7.	 Connect a computer that runs the Windows operating system to either the RS-232 port 
or the Configuration port of the DA (see “Installation and Operation,” starting on 
page 4, for more details).

8.	 Start the FOX Extenders Program and connect to the front panel Configuration (USB) 
port on the DA (see “Starting the program,” on page 14).

9.	 Click Tools > Update firmware or the Update Firmware button ( ). The Extron 
Firmware Loader appears (see figure 13, below).

 

10

Figure 13.	 Extron Firmware Loader Window and File Menu

10.	Select the FOX DA8 Plus and click File > Open. The Choose Firmware File screen 
appears (see figure 14, below).

 

11

11

Figure 14.	 Choose Firmware File Window

11.	Navigate to and select the new firmware file. Click Open. The Choose Firmware File 
window closes.

ATTENTION:	 The firmware file must have an .s19 extension. Other file types can 
cause the DA to stop functioning.

NOTES:	 •	 When downloaded from the Extron website, the firmware is placed in a 
subfolder of C:\Program Files\Extron\Firmware.

	 •	 Valid firmware files must have the file extension .S19. A file with any 
other extension is not a firmware upgrade.

	 •	 The original factory-installed firmware is permanently available on the 
DA. If the attempted firmware upload fails for any reason, the DA reverts 
to the factory-installed firmware.
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12.	In the Firmware Loader window, click Begin (see figure 15, below).

The Total Progress and Progress status bars show the upload progress. The firmware 
upload may take several minutes. Once the status bars have progressed from 0% to 
100%, and Status is listed as Completed, the firmware loader utility resets the DA.

 

12

Figure 15.	 Firmware Loader Screen

13.	Click Exit to close the Firmware Loader.
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Reference 
Information

This section identifies the part numbers for the FOX DA8 Plus and suggested accessories, 
and provides mounting instructions. Topics that are covered include:

•	 Part Numbers and Accessories

•	 Mounting the Unit

Part Numbers and Accessories

FOX DA8 Plus Part Numbers

Models Part Number

FOX DA8 Plus SM (singlemode) 60-1171-02

FOX DA8 Plus MM (multimode) 60-1171-01

Included Parts
These items are included in each order for a FOX DA8 Plus:

Included Parts Part Number

IEC power cord

3-pole captive screw audio connector

FOX DA8 Plus Setup Guide

Extron Software Products DVD 
(FOX Extenders Control Program and FOX DA8 Plus User Guide)

(1) 10 foot LC-LC duplex patch cables 
(SM or MM, depending on the model)

Optional Accessories

Accessories Part Number

RSU 129  9.5-inch 1U universal rack shelf kit 60-190-01

RSB 129  9.5-inch 1U basic rack shelf 60-604-01

MBU 125 under desk mounting kit 70-077-01

MBD 129 through desk mounting kit 70-077-02

USB CFG Cable USB A Male to USB Mini B Male Configuration Cable 26-654-06
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Compatible Equipment
The FOX DA8 Plus is compatible with the following Extron fiber optic devices:

NOTE:	 Ensure that you match the transmission mode, singlemode or multimode, 
among all connected devices.

Fiber Optic RGB Video Models Part Number

FOX 500 (RGB) Tx/Rx (set and individual units ) 60-746-nn

FOXBOX Tx/Rx VGA 60-934-nn

FOXBOX Tx VGA/YUV 60-1058-nn

PowerCage FOX Tx/Rx VGA 70-699-nn

FOX DVI Models Part Number

FOX 500 DVI Tx/Rx 60-859-nn

FOXBOX Tx/Rx DVI 60-935-nn

FOXBOX DVI Plus Tx/Rx 60-1060-nn

Powercage FOX DVI Tx/Rx 70-700-nn

Powercage FOX DVI Plus Tx/Rx 70-873-nn

Fiber Optic HDMI Video Models Part Number

FOXBOX HDMI Tx/Rx 60-1174-nn

PowerCage FOX HDMI Tx/Rx 70-889-nn

FOX AV Models Part Number

FOX AV Tx/Rx 60-941-nn

PowerCage FOX AV Tx/Rx 70-702-nn

FOX Matrix Switcher Part Number

FOX Matrix 14400 enclosure 60-969-01

FOX Matrix 320x enclosure 60-1082-01

FOX Matrix 14400 / 320x card 70-771-nn

FOX Matrix 3200 Switcher enclosure 60-878-01

FOX Matrix 7200 Switcher enclosure 60-1011-01

FOX Matrix 3200 / 7200 card 70-791-nn

Other Fiber Optic Models Part Number

FOX SW8 60-1172-nn

FOX 500 DA6 60-863-nn
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Fiber Cables

Fiber cable assemblies

MHR Mini High Resolution Cable Part Number

4LC MM LC to LC Multimode Fiber Optic Cable Assemblies 26-652-nn

2LC OM4 MM P LC to LC Laser-Optimized Multimode Fiber Optic 
Cable Assemblies — Plenum

26-671-nn

2LC SM P LC to LC Bend-Insensitive Singlemode Fiber Optic Cable 
Assemblies — Plenum

26-670-nn

Bulk fiber cable and termination tools

RG6 Super High Resolution Cable Part Number

OM4 MM P/2K Plenum 2 km (6,562 foot) Spool 22-225-02

SM P/2K Plenum 2 km (6,562 foot) Spool 22-223-02

Fiber Optic Termination Kit Termination Kit 100-656-01

QLC MM/10 Multimode, qty. 10 101-018-01

QLC SM/10 Singlemode, qty. 10 101-017-01
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Mounting the Unit

ATTENTION:	 Installation and service must be performed by authorized personnel only.

The 1U high, half-rack width unit can be placed on a tabletop, mounted on a rack shelf, or 
mounted under or through a desk or other furniture, using any of the following optional 
kits:

•	 Rack Mounting:

•	 RSU 129 — 9.5 inches 1U universal rack shelf kit (part number 60-190-01) 

•	 RSB 129 — 9.5 inches 1U basic rack shelf (part number 60-604-01)

•	 Furniture Mounting:

•	 MBU 125 — Under desk mounting kit (part number 70-077-01)

•	 Through-desk Mounting:

•	 MBD 129 — Through desk mounting kit (part number 70-077-02)

Mount the FOX DA8 Plus in accordance with the instructions provided with the mounting kit.

Rack Mounting UL Guidelines
The following Underwriters Laboratories (UL) guidelines pertain to the installation of the 
FOX DA8 Plus into a rack.

1.	 Elevated operating ambient — If installed in a closed or multi-unit rack assembly, 
the operating ambient temperature of the rack environment may be greater than room 
ambient. Therefore, consider installing the equipment in an environment compatible 
with the +122 °F (+50 °C) maximum ambient temperature (Tma) specified by Extron.

2.	 Reduced air flow — Installation of the equipment in a rack should be such that the 
amount of air flow required for safe operation of the equipment is not compromised.

3.	 Mechanical loading — Mounting of the equipment in the rack should be such that a 
hazardous condition is not achieved due to uneven mechanical loading.

4.	 Circuit overloading — Consideration should be given to the connection of the 
equipment to the supply circuit and the effect that overloading of the circuits might 
have on overcurrent protection and supply wiring. Appropriate consideration of 
equipment nameplate ratings should be used when addressing this concern.

5.	 Reliable earthing (grounding) — Reliable earthing of rack-mounted equipment 
should be maintained. Particular attention should be given to supply connections other 
than direct connections to the branch circuit (such as the use of power strips).
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Extron Headquarters

+1.800.633.9876 (Inside USA/Canada Only)

Extron USA - West	 Extron USA - East 
+1.714.491.1500	 +1.919.850.1000 
+1.714.491.1517 FAX	 +1.919.850.1001 FAX

Extron Europe

+800.3987.6673 
(Inside Europe Only)

+31.33.453.4040 
+31.33.453.4050 FAX

Extron Asia

+800.7339.8766  
(Inside Asia Only)

+65.6383.4400
+65.6383.4664 FAX

Extron Japan

+81.3.3511.7655
+81.3.3511.7656 FAX

Extron China

+4000.398766  
Inside China Only

+86.21.3760.1568 
+86.21.3760.1566 FAX

Extron Middle East

+971.4.2991800
+971.4.2991880 FAX

Extron Korea

+82.2.3444.1571
+82.2.3444.1575 FAX

Extron India

1800.3070.3777 
Inside India Only

+91.80.3055.3777 
+91.80.3055.3737 FAX

© 2012 Extron Electronics   All rights reserved.   www.extron.com

Contact Information

Extron Warranty
Extron Electronics warrants this product against defects in materials and workmanship for a period of three years 
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty 
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, 
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is 
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1001 East Ball Road 
Anaheim, CA 92805 
U.S.A.

 
Japan: 
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe and Africa: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia: 
Extron Asia 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical or 
mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA:	 714.491.1500 or 800.633.9876		  Europe:	 31.33.453.4040  
Asia:	 65.6383.4400		  Japan:	 81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.
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